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Introduction

This document describes how to use the HTMLDOC software, version 1.8.28. HTMLDOC converts
Hyper-Text Markup Language ("HTML") input files into indexed HTML, Adobe® PostScript®, or Adobe
Portable Document Format ("PDF") files.

HTMLDOC supports most HTML 3.2 elements, some HTML 4.0 elements, and can generate title and table |
contents pages. It does not currently support stylesheets.

HTMLDOC can be used as a standalone application, in a batch document processing environment, or &
web-based report generation application.

No restrictions are placed upon the output produced by HTMLDOC.

HTMLDOC is open source software under the terms of version 2 of the GNU General Public License with a
exception that allows for distribution of executables linked to the OpenSSL library.

History

Like many programs, | developed HTMLDOC in response to a need my company had for generatin
high-quality documentation in printed and electronic forms. For a while | used FrameMaker® and a packag
from sgi that generated "compiled" Standard Generalized Markup Language ("SGML") files that could be
used by the Electronic Book Technologies ("EBT") documentation products; EBT was bought by INSO wh
was bought by StelleR¥ who apparently has dropped the whole product line. When sgi stopped supporting

these tools | turned to INSO, but the cost of their tools was prohibitive to my small business.

In the end | decided to write my own program to generate the documentation. HTML seemed to be the sou
format of choice since WYSIWYG HTML editors are widely (and freely) available and at worst you can use :
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plain text editor. | needed HTML output for documentation on my web server, PDF for customers to read
and/or print from their computers, and PostScript for printing needs.

The result of my efforts is the HTMLDOC software which is available for Linux® UNIX®, MacOS® X, and
Microsoft® Windows®. Among other things, this software users manual is produced using HTMLDOC.

HTMLDOC used to be available under a commercial end-user license agreement from my former company,

Easy Software Products. While that company is no longer in business, | continue to maintain and develop
HTMLDOC in my spare time.

Organization of This Manual
This manual is organized into tutorial and reference chapters and appendices:
e Chapter 1 - Installing HTMLDOC
» Chapter 2 - Getting Started
» Chapter 3 - Generating Books
» Chapter 4 - HTMLDOC from the Command-Line
» Chapter 5 - HTMLDOC from a Web Server
» Chapter 6 - HTML Reference
» Chapter 7 - GUI Reference
» Chapter 8 - Command-Line Reference
« Appendix A - License Agreement

» Appendix B - Book File Format
» Appendix C - Release Notes

Encryption Support
HTMLDOC includes code to encrypt PDF document files using the RC4 algorithm with up to a 128-bit key.

While this software and code may be freely used and exported under current US laws, other countries may
restrict your use and possession of this code and software.

Copyright, Trademark, and License Information

HTMLDOC is copyright 2011 by Michael R Sweet. See Appendix A - License Agreement for the terms of
use.

The Adobe Portable Document Format is Copyright 1985-2005 by Adobe Systems Incorporated. Adobe,
FrameMaker, and PostScript are registered trademarks of Adobe Systems, Incorporated.

The Graphics Interchange Format is the copyright an@®'\Gié-the service mark property of CompuServe
Incorporated.

Intel is a registered trademark of Intel Corporation.

Linux is a registered trademark of Linus Torvalds.

Mac OS is a registered trademark of Apple Inc.

Microsoft and Windows are registered trademarks of Microsoft Corporation.
Red Hat and RPM are registered trademarks of Red Hat, Inc.

Solaris is a registered trademark of Sun Microsystems, Inc.

IN-2 History
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SPARC is a registered trademark of SPARC International, Inc.
UNIX is a registered trademark of the X/Open Company, Ltd.

This software is based in part on the work of the Independent JPEG Group and FLTK project.

Copyright, Trademark, and License Information IN-3
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Chapter 1 - Installing HTMLDOC

This chapter describes the steps needed to install HTMLDOC on your system from the source distributions.

Requirements

HTMLDOC requires C and C++ compilers - recent versions of GCC/Clang work fine. To build the GUI you'll
also need:

ast Light Tool Kit ("ELTK"), version 1.1.x or 1.3.X.
» X11 libraries, R5 or higher (needed to build under UNIX/Linux only.)

Secure (https) URL support can be enabled via the OpenSSL or GNU TLS libraries, among others.

Compiling under UNIX/Linux

HTMLDOC uses a configuration script produced by GNU autoconf to configure itself for your system. If your
C compiler is not called cc or gcc, set the cc environment variable to the name and path of your C compiler:

% setenv CC /path/to/compiler ENTER [C Shell]
% CC=/path/to/compiler; export CC ENTER  [Bourne/Korn Shell]

Similarly, if your C++ compiler is not called CC, gcc, c++, or g++, set the CxX environment variable to the
name and path of your C++ compiler:

% setenv CXX /path/to/compiler ENTER [C Shell]
% CXX=/path/to/compiler; export CXX ENTER [Bourne/Korn Shell]

Chapter 1 - Installing HTMLDOC 1-1


http://www.fltk.org
ftp://ftp.x.org
http://www.openssl.org/
http://www.gnutls.org/

HTMLDOC 1.8.28 Software Users Manual
Then run the following command to configure HTMLDOC for installation in the default directories:

% ./configure ENTER

The default configuration will install HTMLDOC in the /usr/bin directory with the data files under
/usr/share/htmldoc and the documentation and on-line help under /usr/share/doc/htmldoc. Use the
--prefix option to change the installation prefix to a different directory such as /ust/local:

% ./configure --prefix=/ust/local ENTER

If the OpenSSL library is not installed in a standard location for your compilers, use the
--with-openssl-includes and --with-openssl-libs options to point to the OpenSSL library:

% ./configure --with-openssl-libs=/path/to/openssl/lib \
--with-openssl-includes=/path/to/openssl ENTER

HTMLDOC is built from a Makefile in the distribution's main directory. Simply run the "make" command to
build HTMLDOC:

% make ENTER

If you get any fatal errors, please report them on the htmidoc mailing list referenced on the HTMI DOC
project page.

Please note the version of HTMLDOC that you are using as well as any pertinent system information such as
the operating system, OS version, compiler, and so forth. Omitting this information may delay or prevent a
solution to your problem.

Once you have compiled the software successfully, you may install HTMLDOC by running the following
command:

% make install ENTER

If you are installing in a restricted directory like /usr then you'll need to be logged in as root.

Compiling on Windows Using Visual C++

A Visual C++ 2008 workspace file and associated project files are included in the source distribution under
the "visualc" directory. Open the workspace file "htmldoc.dsw", adjust the FLTK include and project file
locations, and then build the HTMLDOC target.

Note:

You also need to download the FLTK library in order to compile HTMLDOC with
Visual C++.

Installing with Visual C++

To install HTMLDOC with Visual C++, open the MSI file that is created by the Visual C++ solution file.
That will populate the necessary registry entries:

HKEY_LOCAL_MACHINE\Software\HTMLDOC\data

C:\installation\directory
HKEY_LOCAL_MACHINE\Software\HTMLDOC\doc

C:\installation\directory\doc
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http://www.msweet.org/projects/HTMLDOC

Chapter 2 - Getting Started

This chapter describes how to start HTMLDOC and convert HTML files into PostScript and PDF files.

Note:

HTMLDOC currently does not support HTML 4.0 features such as stylesheets qr the
STYLE, TBODY, THEAD, or TFOOT elements. For more information, please consull

Chapter 6 - HTML Reference.

Starting HTMLDOC

For Windows click:

Start Menu->All Programs->HTMLDOC->HTMLDOC
For MacOS X click:

Applications Folder->HTMLDOC
For Linux click:

Applications Menu->Office->HTMLDOC

or type:

htmldoc ENTER
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For Solaris click:

Applications Window->ESP->HTMLDOC

or type:

htmldoc ENTER

Choosing a HTML File

The HTMLDOC window (Figure 2-1) shows the list of input files that will be converted. Start by clicking on
the Web Page radio button (1) to specify that you will be converting a HTML web page file.

HR NewBook{meodified) - HTMLDOC 1.8.24 Commercial - 10] x|
Input Output Page 10 Colors Fonts P PDF | Security| Options |
Document Type:  Book _niven Page
Input Files: Add Files... |
o R;RLM |
Edit Q
Delete FITER
ke I_Ip
Move Diown
Lago Image: Browse.. |
Title File/image: Browse. ..
Help | Mew  Cpen.. = Save  SaveAs.. Generate  Close |
HTMLDOC 1.8.24 Commercial Ready.

Figure 2-1 - The HTMLDOC Window
Then choose a file for conversion by clicking on the Add Files... button (2). When the file chooser dialog

appears (Figure 2-2), double-click on the HTML file (3) you wish to convert from the list of files. If you don't
see the file you wish to add, then double click on the folder with ../ (4) to see more file options.
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ed| |
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Add HTML Files?
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Favorites ol BRI Py
| <htm]l>"M
=hody="M
“M
<!—— FOOTER BRICGHT "1

=div align='justify'
~M
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HTMLDOC</fa-< /hl-"H
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href='#COMPILE' »Appe
Source<fax_ </ /p>"N

~M
=hZrBemairement =< he

Filenarme:  cimiketmldoc-1.8/docs1-install.html

e Cancel

Setting the Output File

You've chosen your HTML files to be converted, now you need to save your file(s) somewhere. The outp
file is where you would do that. Click on the Output tab (5) to set the output file (Figure 2-3). You can eithet
type the name of the output file into the Output Path field or click on the Browse... button (6) to find an

acceptable output location. Clicking on browse allows you to put the new file in a specific folder for eas
retrieval. When you click on a folder you will notice that the filename area and text is highlighted. Click a few
times at the end of the file name path and add a slash (/) and the name of the new file. If you don't see t

Figure 2-2 - The File Chooser Dialog

folder you want to put your document in, double click on the folder with ../ after it.

Choosing a HTML File
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HP NewBook{modified) - HTMLDOC 1.8.24 Commercial o ] |

Input ut Page 10 Colors Fonts| Po | PDF | Security Options |

* File Directory

T

Browse. .

Output Pat

Output Farmat: HT L Separates HThL eEr B
Output Options: ~ Grayscale  Title Page  JPEG Big Ima @

Cormpression:

Maone Fa“st Best

ey &
JPEG Quuality: | 99
Food Best

Generate | Close |

Help || Mew | Open.. = Save  SaveAs..
HTMLDOC 1.8.24 Commercial R.E?'R

Figure 2-3 - The Output Tab

Generating the Document

You can generate the document by clicking on the Generate button (7) at the bottom of the HTMLDOC
window. When the conversion is completed you can open the PDF file that is produced using Adobe Acrobat

Reader or any other PDF viewing application.

Note:

The Open button at the bottom of the HTMLDOC GUI Open Window will not open
the generated document for viewing. You will learn about the Open button in later

chapters.
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Chapter 3 - Generating Books

This chapter describes how to create a book using HTML files.

Overview

While HTMLDOC can convert web pages into PostScript and PDF files, its real strength is generatin
indexed HTML, PostScript, or PDF books.

HTMLDOC uses HTML heading elements to delineate chapters and headings in a book. The H1 element
used for chapters:

<HTML>
<HEAD>
<TITLE>The Little Computer that Could</TITLE>
</HEAD>
<BODY>
<H1>Chapter 1 - The Little Computer is Born</H1>

;.H1>Chapter 2 - Little Computer's First Task</H1>

</BODY>
</HTML>

Sub-headings are marked using the H2 through Hé elements.
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Note:

When using book mode, HTMLDOC starts rendering with the first H1 element. Any
text, images, tables, and other viewable elements that precede the first H1 element are
silently ignored. Because of this, make sure you have an H1 element in your HTML
file, otherwise HTMLDOC will not convert anything.

Choosing HTML Files

Start by clicking on the Book radio button (1) to specify you'll be converting one or more HTML files into a
book.

Your next step is to choose one or more files for conversion by clicking on the Add Files... button (2). When
the file chooser dialog appears, pick the file(s) you wish to convert and then click on the OK button. As
discussed in Chapter 2, if you don't see the file that you want, double click on the folder with ../ after it.

Also, having all files and images in one folder will make file retrieval much easier.

HR htmidoc.book - HTMLDOC 1.8.24 Commercial - 10] x|

Input. Output Page TOC Colors Fonts Fo PDF | Security Options |

Document Type:  « Book  Continuous — Weh Page

Input Files: thtrm | Add Files. .
= 'rﬂ.html
=] 2-stating.htrml
=] 3-books html
=] 4-cmdline html
2] 5-cgihtml : -
=1 A-himiref himl i i
Logo Image: Browse. .
Title Filedimage: Browse. .
Help Mew — Open.. Save Save As.. Generate

HTMLDOC 1.8.24 Cammercial Ready.

Figure 3-1: The Input Tab

Selecting a Title File

HTMLDOC can automatically create a title page for you. Fill in the Title File/Image field or click the
Browse... button (3) to locate the file you want to use. If you don't see the file you want, double click on the
folder with ../ after it.

3-2 Overview
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HR htmidoc.book - HTMLDOC 1.8.24 Commercial ] o ] |

'Page TOC Colors Fonts PS5 PDF | Security Options

t Ta: + File Cirectory

Output
Dutput Format: HTRIL Separated HTML Bl K
Output Options:  Grayscale v Title Page  « JPEG Big Imag Q

Cormpression:

trnidoc pdf Browse...

Mone Fast Ele:-':t
JPEG Quality: = 75 L —
Zood Best
Help | Mew Open.. Save  SaveAs..  Generate | Close
HTMLDOC 184 Commercial Ready!

Figure 3-2: The Output Tab

Setting the Output Format

The output format is set in the Output tab (4). Click on the Output tab and then click on the HTML, PS, or
PDF radio buttons to set the output format.

Setting the Output File

Now that you've chosen an output format, type the name of the output file into the Output Path field or click
on the Browse... button (5) to select the output file using the file chooser.

Generating the Document

Once you have chosen the output file you can generate it by clicking on the Generate button (6) at th
bottom of the HTMLDOC window.

Saving Your Book

HTMLDOC can save the list of HTML files, the title file, and all other options to a special .BOOK file so you
can regenerate your book when you make changes to your HTML files.

Click on the Save button (7) to save the current book to a file.
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Saving Your Book



Chapter 4 - HTMLDOC from the Command-Line

This chapter describes how to use HTMLDOC from the command-line to convert web pages and generz
books.

Getting to the Command-Line on Windows

Do the following steps to access the command-line on Windows:
1. Click on Start at the bottom left corner of your screen
2. Click on All Programs

3. Click on Accessories
4. Click on Command Prompt

After you have clicked command prompt, your screen should look something like Figure 4-1.
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ommand Prompt

Microzoft Windows 2808 [Uersion 5.66@.21951]
CC) Copyright 1785-2000 Microsoft Corp.

C:sDocuments and Settingsmike>

Figure 4-1: Command prompt window

To see what's in this directory, type the following command:

dir ENTER
You now have a list of available files and directories that you can use. To access a different directory simply

type cd and the name of the new directory. For example, type the following if you want to access a directory
called Steve:

cd Steve ENTER

The Basics of Command-Line Access
To convert a single web page type:
htmldoc --webpage -f output.pdf filename.html ENTER
What Are All These Commands?
htmidoc is the name of the software.
--webpage is the document type that specifies unstructured files with page breaks between each file.

-f output.pdf is the file name that you will save all the documents into and also the type of file it is. In this
example it is a PDF file.

filename.html is the name of the file that you want to be converted and the type of file it is. In this example
it is a HTML file.

Try the following exercise: You want to convert the file myhtml.html into a PDF file. The new file will be
called mypdf.pdf. How would you do this? (Don't worry, it's answered for you on the next line. But try first.)

To accomplish this type:

htmldoc --webpage -f mypdf.pdf myhtml.html ENTER
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Converting Multiple HTML Files
To convert more than one web page with page breaks between each HTML file, type:
htmldoc --webpage -f output.pdf file1.html file2.html ENTER
All we are doing is adding another file. In this example we are converting two files: filel.html and file2.html.

Try this example: Convert one.html and two.html into a PDF file named 12pdf.pdf. Again, the answer is on
the next line.

Your line command should look like this:

htmldoc --webpage -f 12pdf.pdf one.html two.html ENTER

We've been using HTML files, but you can also use URLs. For example:

htmldoc --webpage -f output.pdf http://slashdot.org/ ENTER

Generating Books

Type one of the following commands to generate a book from one or more HTML files:

htmldoc --book -f output.html file1.html file2.html ENTER
htmldoc --book -f output.pdf filel.html file2.html ENTER
htmldoc --book -f output.ps filel.html file2.html ENTER

What are all these commands?
htmidoc is the name of the sofware.
--book is a type of document that specifies that the input files are structured with headings.

-f output.ntml is where you want the converted files to go to. In this case, we requested the file be a HTML
file. We could have made it a PDF (-f output.pdf) or Postscript (-f ouput.ps), too.

filel.html and file2.html are the files you want to convert.

HTMLDOC will build a table of contents for the book using the heading elements (H1, H2, etc.) in your
HTML files. It will also add a title page using the document TITLE text (you're going to learn about title files
shortly) and other META information you supply in your HTML files. See Chapter 6 - HTML Reference for
more information on the META variables that are supported.

Note:

When using book mode, HTMLDOC starts rendering with the first H1 element. Any
text, images, tables, and other viewable elements that precede the first H1 element are
silently ignored. Because of this, make sure you have an H1 element in your HT|ML
file, otherwise HTMLDOC will not convert anything!
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Setting the Title File

The --titlefile option sets the HTML file or image to use on the title page:

htmldoc --titlefile filename.bmp ... ENTER
htmldoc --titlefile filename.gif ... ENTER
htmldoc --titlefile filename.jpg ... ENTER
htmldoc --titlefile filename.png ... ENTER
htmidoc --titlefile filename.html ... ENTER

HTMLDOC supports BMP, GIF, JPEG, and PNG images, as well as generic HTML text you supply for the
title page(s).

Putting It All Together
htmldoc --book -f 12book.pdf 1book.html 2book.html --titlefile bookcover.jpg ENTER

Take a look at the entire command line. Dissect the information. Can you see what the new filename is? What
are the names of the files being converted? Do you see the titlepage file? What kind of file is your titlefile?

Figure it out? The new file is 12book.pdf. The files converted were 1book.html and 2book.html. A title
page was created using the JPEG image file bookcover.jpg.

Chapter 8 - Command Line Reference digs deeper into what you can do with the the command line prompt.

4-4 Setting the Title File



Chapter 5 - Using HTMLDOC on a Web Server

This chapter describes how to interface HTMLDOC to your web server using CGI and your own server-sic
scripts and programs.

The Basics

HTMLDOC can be used in a variety of ways to generate formatted reports on a web server. The ma
common way is to use HTMLDOC as a CGI program with your web server to provide PDF-formatted outpu
of a web page. Examples are provided for Microsoft IIS and the Apache web servers.

HTMLDOC can also be called from your own server-side scripts and programs. Examples are provided f
PHP and Java.

WARNING:

Passing information directly from the web browser to HTMLDOC can potentially
expose your system to security risks. Always be sure to "sanitize" any input from the
web browser so that filenames, URLS, and options passed to HTMLDOC are nat
acted on by the shell program or other processes. Filenames with spaces must{usually
be enclosed with quotes.

Using HTMLDOC as a CGI Program

HTMLDOC 1.8.24 and higher supports operation as a CGI program. You can copy or symlink the htmldoc
(all but Windows) or htmldoc.exe (Windows) executable to your web server's cgi-bin directory and then use
it to produce PDF versions of your web pages.
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The CGI converts a page on your local server to PDF and sends it to the client's web browser. For example, to
convert a page called superproducts.html at the following URL.:

http://servername/superproducts.html

and if you installed HTMLDOC in your server's cgi-bin directory, you would direct your clients to the
following URL.:

http://servername/cgi-bin/htmldoc/superproducts.html

The boldface portion represents the location of the HTMLDOC executable on the web server. You simply
place that path before the page you want to convert.

Form data using the GET method can be passed at the end of the URL, for example:

http://servername/cgi-bin/htmldoc/superproducts.html?name=value

Server-Side Preferences

When run as a CGI program, HTMLDOC will try to read a book file to set any preferences for the conversion
to PDF. For the superproducts.html file described previously, HTMLDOC will look at the following URLs
for a book file:

http://servername/superproducts.html.book
http://servername/.book
http://servername/cgi-bin/.book

The first book file that is found will be used.

Configuring HTMLDOC with Apache

The Apache web server is easily configured to use HTMLDOC. The simplest way is to copy or symlink the
htmldoc executable to the configured cgi-bin directory. For example, if your Apache installation is
configured to look for CGI programs in the /var/www/cgi-bin directory, the default for Apache on Red Hat
Linux, then the command to install HTMLDOC on your web server would be:

In -s /usr/bin/htmlidoc /var/www/cgi-bin ENTER

If you are using Apache 2.0.30 or higher, you will also need to enable PATH_INFO support by adding the
following line to your httpd.conf file:

AcceptPathinfo On

Apache also allows you to associate CGI programs with a specific extension. If you add the following line to
your httpd.conf file:

AddHandler cgi-script .cgi
and enable CGI execution with the Options directive for a directory:

Options +ExecCGl
then you can copy or symlink the htmldoc executable to an alternate location. For example, if you have a web
directory called /var/www/htdocs/products, you can install HTMLDOC in this directory with the following

command:

In -s /usr/bin/htmlidoc /var/www/htdocs/products/htmlidoc.cgi ENTER
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Configuring HTMLDOC with Microsoft IS

The 1IS web server is configured to run CGI programs by either modifying the permissions of an existin
directory or by creating a new virtual directory that allows for execution of programs. Start by running the
Internet Services Manager program (Figure 5-1):

1. Click on Start

2. Click on Settings

3. Click on Control Panel

4. Double-click on Administrative Tools

5. Double-click on Internet Services Manager

After the Internet Services Manager window (Figure 5-1) appears, perform the following steps to add a
virtual folder for HTMLDOC:

1. Click on your server in the list to show the default web site service in the list (Figure 5-2)
2.Choose New->Virtual Directory from the Action menu (Figure 5-3)

3. Click Next when the Virtual Directory Creation Wizard window appears (Figure 5-4)

4. Enter the name htmidoc in the Alias field and click Next (Figure 5-5)

5. Enter the HTMLDOC program folder in the Directory field and click Next (Figure 5-6)

6. Check the Execute (such as ISAPI applications or CGI) box and click Next (Figure 5-7)
7. Click Finish to dismiss the wizard (Figure 5-8)

If you are using IIS 6.0, proceed to the next section titled, "Additional Configuration for IIS 6.0".

¥g Internet Information Services ' o [m]
| action vew || = = [@@m|B |22 » = 0 | |
Tree I Compuker | Local | Conneckion Tyvpe | Stakus

B+ nancy Yes TCRjIP

- B * nancy

4] | i
| |

Figure 5-1: The Internet Services Manager Window
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Figure 5-2: The Default Web Site Service
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Figure 5-3: Adding a New Virtual Directory
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Figure 5-5: Entering the Alias Name
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¥irtual Directory Creation Wizard x|
Web Site Content Directory i
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Figure 5-6: Entering the HTMLDOC Program Folder
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Figure 5-7: Enabling CGI Mode
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¥irtual Directory Creation Wizard x|

You have successfully

@ completed the Virtual
Directory Creation Wizard.

Click Finizh to continue.

¢ Hack

[Eancel I

Figure 5-8: Completion of IIS Configuration

Once configured, the htmldoc.exe program will be available in the web server directory. For example, for &
virtual directory called cgi-bin, the PDF converted URL for the superproducts.html page would be as
follows:

http://servername/cgi-bin/htmldoc.exe/superproducts.html

The boldface portion represents the location of the HTMLDOC program on the web server.

Additional Configuration for IIS 6.0

IS 6.0 requires additional configuration steps due to its increased focus on security. Start by running tt
Internet Services Manager program (Figure 5-1):

1. Click on Start

2. Click on Settings

3. Click on Control Panel

4. Double-click on Administrative Tools

5. Double-click on Internet Services Manager

After the Internet Services Manager window (Figure 5-1) appears, perform the following steps to add a
new Wed Service Extension for HTMLDOC:

1. Click on Web Service Extensions

2. Click Add a new Web Service Extension

3. Enter the name "HTMLDOC" when the Web Service Extension window appears

4.Click Add... and choose the htmldoc.exe file from the program folder, typically
C:\Program Files\Easy Software Products\HTMLDOC

5. Check the Set extension status to Allowed box

6. Click OK to add the extension and dismiss the window
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Finally, double-click the My Computer icon on the desktop or start the Windows Explorer. When the
explorer window appears, perform the following steps to provide write access to the Windows temporary
folder:

1. Open the windows temporary file folder, typically C:\WINDOWS\TEMP

2. Choose Properties from the File menu

3. Click on the Security tab

4. Click Add..., enter the username for the web server, typically "SERVER\IUSR_SERVER" where
"SERVER" is the name you gave your server, and click OK

5. Click on the username you just added in the list

6. Check the Read and Write permissions

7. Click OK to save the changes

Using HTMLDOC From Server-Side Scripts and Programs

To make this work the CGI script or program must send the appropriate HTTP attributes, the required empty
line to signify the beginning of the document, and then execute the HTMLDOC program to generate the
HTML, PostScript, or PDF file as needed. Since HTMLDOC looks for CGI environment variables when it is
run, you must also set the HTMLDOC_NOCGI environment variable to a value of 1 before running HTMLDOC
from your CGI script or program.

Another way to generate PDF files from your reports is to use HTMLDOC as a "portal" application. When

used as a portal, HTMLDOC automatically retrieves the named document or report from your server and
passes a PDF version to the web browser. See the next sections for more information.
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Calling HTMLDOC from a Shell Script

Shell scripts are probably the easiest to work with, but are normally limited to GET type requests. Here is
script called topdf that acts as a portal, converting the named file to PDF:

#!/bin/sh

#

# Sample "portal” script to convert the named HTML file to PDF on-the-fly.
#

# Usage: http://www.domain.com/path/topdf/path/filename.html

#

#
# Tell HTMLDOC not to run in CGI mode...
#

HTMLDOC_NOCGI=1; export HTMLDOC_NOCGI

#

# The "options" variable contains any options you want to pass to HTMLDOC.
#

options="-t pdf --webpage --header ... --footer ..."

#

# Tell the browser to expect a PDF file...

#

echo "Content-Type: application/pdf"
echo ™

#
# Run HTMLDOC to generate the PDF file...
#

htmidoc $options http://${SERVER_NAME}:${SERVER_PORT}$PATH_INFO

Users of this CGI would reference the URL "http://www.domain.com/topdf.cgi/index.html" to generate a PDF
file of the site's home page.

The options variable in the script can be set to use any supported command-line option for HTMLDOC; for
complete list see Chapter 8 - Command-Line Reference.
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Calling HTMLDOC from Perl

Perl scripts offer the ability to generate more complex reports, pull data from databases, etc. The easiest way
to interface Perl scripts with HTMLDOC is to write a report to a temporary file and then execute HTMLDOC
to generate the PDF file.

Here is a simple Perl subroutine that can be used to write a PDF report to the HTTP client:

sub topdf {
# Get the filename argument...
my $filename = shift;

# Make stdout unbuffered...
select(STDOUT); $| = 1;

# Tell HTMLDOC not to run in CGIl mode...
$ENV{HTMLDOC_NOCGI} = 1;

# Write the content type to the client...
print "Content-Type: application/pdfin\n";

# Run HTMLDOC to provide the PDF file to the user...
system "htmldoc -t pdf --quiet --webpage $filename”;

}
Calling HTMLDOC from PHP

PHP provides a passthru() function that can be used to run HTMLDOC. This combined with the header()
function can be used to provide on-the-fly reports in PDF format.

Here is a simple PHP function that can be used to convert a HTML report to PDF and send it to the HTTP
client:

function topdf($filename, $options = ") {
# Tell HTMLDOC not to run in CGI mode...
putenv("HTMLDOC_NOCGI=1");

# Write the content type to the client...
header("Content-Type: application/pdf");
flush();

# Run HTMLDOC to provide the PDF file to the user...

passthru(“htmidoc -t pdf --quiet --jpeg --webpage $options '$filename"™);
}

The function accepts a filename and an optional "options" string for specifying the header, footer, fonts, etc.
To prevent malicious users from passing in unauthorized characters into this function, the following function

can be used to verify that the URL/filename does not contain any characters that might be interpreted by the
shell:
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function bad_url($url) {
/I See if the URL starts with http: or https:...
if (strncmp($url, "http://*, 7) 1= 0 &&
strncmp($url, "https://*, 8) = 0) {
return 1;

}

/I Check for bad characters in the URL...
$len = strien($url);
for ($i = 0; $i < $len; $i ++) {
if (Istrchr("~_*()/:%?+-&@;=,$.", $url[$i]) &&
Ictype_alnum($url[$i])) {
return 1;
}
}

return O;

}

Another method is to use the escapeshellarg() function provided with PHP 4.0.3 and higher to generate a
guoted shell argument for HTMLDOC.

To make a "portal” script, add the following code to complete the example:

global $SERVER_NAME;
global $SERVER_PORT;
global $PATH_INFO;
global $QUERY_STRING;

if (SQUERY_STRING !="") {

$url = "http://${SERVER_NAME}:${SERVER_PORT}${PATH_INFO}?${QUERY_STRING}",
}else {

$url = "http://${SERVER_NAME}.${SERVER_PORT}$PATH_INFO";

if (bad_url($url)) {
print("<htmi><head><title>Bad URL</title></head>\n"
."<body><h1>Bad URL</h1>\n"
"<p>The URL <b><tt>$url</tt></b> is bad.</p>\n"
"</body></htmI>\n");
}else {
topdf($url);

Calling HTMLDOC from PHP 5-11



HTMLDOC 1.8.28 Software Users Manual
Calling HTMLDOC from C

C programs offer the best flexibility and easily supports on-the-fly report generation without the need for
temporary files.

Here are some simple C functions that can be used to generate a PDF report to the HTTP client from a
temporary file or pipe:

#include <stdio.h>
#include <stdlib.h>

/* topdf() - convert a HTML file to PDF */

FILE *topdf(const char *filename) [*1 - HTML file to convert */
{

char  command[1024]; /* Command to execute */

/*

* Tell HTMLDOC not to run in CGIl mode...
*/

putenv("HTMLDOC_NOCGI=1");
/*
* Write the content type to the client...
*
/
puts("Content-Type: application/pdfin");
/*
* Run HTMLDOC to provide the PDF file to the user...
*
/
sprintf(command, "htmldoc --quiet -t pdf --webpage %s", filename);

return (popen(command, "w"));

[* topdf2() - pipe HTML output to HTMLDOC for conversion to PDF */
FILE *topdf2(void)

{
/*
* Tell HTMLDOC not to run in CGI mode...
*/
putenv("HTMLDOC_NOCGI=1");
/*
* Write the content type to the client...
*/
puts("Content-Type: application/pdfin");
/*

* Open a pipe to HTMLDOC...
*
/

return (popen("htmldoc --quiet -t pdf --webpage -", "w"));
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Calling HTMLDOC from Java

Java programs are a portable way to add PDF support to your web server. Here is a class called htmldoc t
acts as a portal, converting the named file to PDF. It can also be called by your Java servlets to process
HTML file and send the result to the client in PDF format:

class htmldoc

/I Convert named file to PDF on stdout...
public static int topdf(String filename)// | - Name of file to convert

{
String command,; /I Command string
Process process; /I Process for HTMLDOC
Runtime runtime; /I Local runtime object
java.io.InputStream input; /I Output from HTMLDOC
byte buffer []; /l Buffer for output data
int bytes; /I Number of bytes

/I First tell the client that we will be sending PDF...
System.out.print("Content-type: application/pdfin\n");

/I Construct the command string
command = "htmldoc --quiet --jpeg --webpage -t pdf --left 36 " +
"--header .t. --footer .1. " + filename;

/I Run the process and wait for it to complete...
runtime = Runtime.getRuntime();

try

/I Create a new HTMLDOC process...
process = runtime.exec(command);

/I Get stdout from the process and a buffer for the data...
input = process.getinputStream();
buffer = new byte[8192];

/I Read output from HTMLDOC until we have it all...
while ((bytes = input.read(buffer)) > 0)
System.out.write(buffer, 0, bytes);

/I Return the exit status from HTMLDOC...
return (process.waitFor());

catch (Exception e)

/I An error occurred - send it to stderr for the web server...
System.err.print(e.toString() + " caught while running:\n\n");
System.err.print(" "+ command + "\n");

return (1);

}

/I Main entry for htmldoc class
public static void main(String[] args)// | - Command-line args

{

String server_name, /l SERVER_NAME env var
server_port, /l SERVER_PORT env var
path_info, /I PATH_INFO env var
query_string, /I QUERY_STRING env var
filename; I File to convert

if ((server_name = System.getProperty("SERVER_NAME")) = null &&
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(server_port = System.getProperty("SERVER_PORT")) != null &&
(path_info = System.getProperty("PATH_INFO")) != null)

/I Construct a URL for the resource specified...

filename = "http://" + server_name + ":" + server_port + path_info;
if ((query_string = System.getProperty("QUERY_STRING")) != null)

filename = filename + "?" + query_string;

}
}
else if (args.length == 1)

/I Pull the filename from the command-line...
filename = args[0];

}

else

/I Error - no args or env variables!
System.err.print("Usage: htmldoc.class filename\n");
return;

}

/I Convert the file to PDF and send to the web client...
topdf(filename);
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Chapter 6 - HTML Reference

This chapter defines all of the HTML elements and attributes that are recognized and supported |
HTMLDOC.

General Usage

There are two types of HTML files - structured documents using headings (H1, H2, etc.) which HTMLDOC
calls "books", and unstructured documents that do not use headings which HTMLDOC calls "web pages".

A very common mistake is to try converting a web page using:
htmldoc -f filename.pdf filename.html

which will likely produce a PDF file with no pages. To convert web page files you must use the --webpage
option at the command-line or choose Web Page in the input tab of the GUI.

Note:

HTMLDOC does not support HTML 4.0 elements, attributes, stylesheets, or scrjpting.
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The following HTML elements are recognized by HTMLDOC:

6-2

Element Version | Supported? Notes
IDOCTYPE 3.0 Yes DTD is ignored
A 1.0 Yes See Below
ACRONYM 2.0 Yes No font change
ADDRESS 2.0 Yes
AREA 2.0 No
B 1.0 Yes
BASE 2.0 No
BASEFONT 1.0 No
BIG 2.0 Yes
BLINK 2.0 No
BLOCKQUOTE 2.0 Yes
BODY 1.0 Yes
BR 2.0 Yes
CAPTION 2.0 Yes
CENTER 2.0 Yes
CITE 2.0 Yes Italic/Oblique
CODE 2.0 Yes Courier
DD 2.0 Yes
DEL 2.0 Yes Strikethrough
DFEN 2.0 Yes Helvetica
DIR 2.0 Yes
DIV 3.2 Yes
DL 2.0 Yes
DT 2.0 Yes Italic/Oblique
EM 2.0 Yes Italic/Oblique
EMBED 2.0 Yes HTML Only
FONT 2.0 Yes See Below
FORM 2.0 No
FRAME 3.2 No

Elements
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Element Version | Supported? Notes
FRAMESET 3.2 No
H1 1.0 Yes Boldface,_ See Below
H2 1.0 Yes Boldface,_See Below
H3 1.0 Yes Boldface,_See Below
H4 1.0 Yes Boldface,_See Below
H5 1.0 Yes Boldface, See Below
H6 1.0 Yes Boldface,_ See Below
HEAD 1.0 Yes
HR 1.0 Yes See Below
HTML 1.0 Yes
I 1.0 Yes
IMG 1.0 Yes See Below
INPUT 2.0 No
INS 2.0 Yes Underline
ISINDEX 2.0 No
KBD 2.0 Yes Courier Bold
LI 2.0 Yes
LINK 2.0 No
MAP 2.0 No
MENU 2.0 Yes
META 2.0 Yes See Below
MULTICOL N3.0 No
NOBR 1.0 No
NOFRAMES 3.2 No
oL 2.0 Yes
OPTION 2.0 No
P 1.0 Yes
PRE 1.0 Yes
S 2.0 Yes Strikethrough
SAMP 2.0 Yes Courier
SCRIPT 2.0 No
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Element Version | Supported? Notes
SELECT 2.0 No
SMALL 2.0 Yes
SPACER N3.0 Yes
STRIKE 2.0 Yes
STRONG 2.0 Yes Boldface Italic/Oblique
SUB 2.0 Yes Reduced Fontsize
SUP 2.0 Yes Reduced Fontsize
TABLE 2.0 Yes See Below
TD 2.0 Yes
TEXTAREA 2.0 No
TH 2.0 Yes Boldface Center
TITLE 2.0 Yes
TR 2.0 Yes
TT 2.0 Yes Courier
U 1.0 Yes
UL 2.0 Yes
VAR 2.0 Yes Helvetica Oblique
WBR 1.0 No

Comments

HTMLDOC supports many special HTML comments to initiate page breaks, set the header and footer text,
and control the current media options:

<l-- FOOTER LEFT "foo" -->

Sets the left footer text; the test is applied to the current page if empty, or the next page otherwise.
<l-- FOOTER CENTER "fo0" -->

Sets the center footer text; the test is applied to the current page if empty, or the next page otherwise.
<l-- FOOTER RIGHT "foo" -->

Sets the right footer text; the test is applied to the current page if empty, or the next page otherwise.
<l-- HALF PAGE -->

Break to the next half page.
<l-- HEADER LEFT "foo" -->

Sets the left header text; the test is applied to the current page if empty, or the next page otherwise.
<l-- HEADER CENTER "foo" -->

Sets the center header text; the test is applied to the current page if empty, or the next page otherwise.
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<l-- HEADER RIGHT "foo" -->

Sets the right header text; the test is applied to the current page if empty, or the next page otherwise
<l-- MEDIA BOTTOM nnn -->

Sets the bottom margin of the page. The "nnn" string can be any standard measurement value, €

0.5in, 36, 12mm, etc. Breaks to a new page if the current page is already marked.
<l-- MEDIA COLOR "foo" -->

Sets the media color attribute for the page. The "foo" string is any color name that is supported by tt

printer, e.g. "Blue”, "White", etc. Breaks to a new page or sheet if the current page is already markec
<l-- MEDIA DUPLEX NO -->

Chooses single-sided printing for the page; breaks to a new page or sheet if the current page is alre;

marked.
<I-- MEDIA DUPLEX YES -->

Chooses double-sided printing for the page; breaks to a new sheet if the current page is alrea

marked.
<l-- MEDIA LANDSCAPE NO -->

Chooses portrait orientation for the page; breaks to a new page if the current page is already markec
<l-- MEDIA LANDSCAPE YES -->

Chooses landscape orientation for the page; breaks to a new page if the current page is alree

marked.
<l-- MEDIA LEFT nnn -->

Sets the left margin of the page. The "nnn" string can be any standard measurement value, e.g. 0.t

36, 12mm, etc. Breaks to a new page if the current page is already marked.
<I-- MEDIA POSITION nnn -->

Sets the media position attribute (input tray) for the page. The "nnn" string is an integer that usuall

specifies the tray number. Breaks to a new page or sheet if the current page is already marked.
<l-- MEDIA RIGHT nnn -->

Sets the right margin of the page. The "nnn" string can be any standard measurement value, e.g. 0.

36, 12mm, etc. Breaks to a new page if the current page is already marked.
<I-- MEDIA SIZE foo -->

Sets the media size to the specified size. The "foo" string can be "Letter", "Legal”, "Universal", ol
"A4" for standard sizes or "WIDTHXHEIGHTunits" for custom sizes, e.g. "8.5x11in"; breaks to a new

page or sheet if the current page is already marked.
<!-- MEDIA TOP nnn -->

Sets the top margin of the page. The "nnn" string can be any standard measurement value, e.g. 0.!

36, 12mm, etc. Breaks to a new page if the current page is already marked.
<l-- MEDIA TYPE "foo" -->

Sets the media type attribute for the page. The "foo" string is any type name that is supported by t|
printer, e.g. "Plain", "Glossy", etc. Breaks to a new page or sheet if the current page is alreac

marked.
<!-- NEED length -->

Break if there is less than length units left on the current page. The length value defaults to lines of

text but can be suffixed by in, mm, or cm to convert from the corresponding units.
<l-- NEW PAGE -->

Break to the next page.
<l-- NEW SHEET -->

Break to the next sheet.
<l-- NUMBER-UP nn -->

Sets the number of pages that are placed on each output page. Valid values are 1, 2, 4, 6, 9, and 16
<l-- PAGE BREAK -->

Break to the next page.
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Header/Footer Strings

The HEADER and FOOTER comments allow you to set an arbitrary string of text for the left, center, and right
headers and footers. Each string consists of plain text; special values or strings can be inserted using the dollar

sign ($):

$$
Inserts a single dollar sign in the header.

$CHAPTER
Inserts the current chapter heading.

$CHAPTERPAGE

$CHAPTERPAGE (format)
Inserts the current page number within a chapter or file. When a format is specified, uses that numeric
format (1 = decimal, i = lowercase roman numerals, | = uppercase roman numerals, a = lowercase
ascii, A = uppercase ascii) for the page numbers.

$CHAPTERPAGES

$CHAPTERPAGES(format)
Inserts the total page count within a chapter or file. When a format is specified, uses that numeric
format (1 = decimal, i = lowercase roman numerals, | = uppercase roman numerals, a = lowercase
ascii, A = uppercase ascii) for the page count.

$DATE

Inserts the current date.
$HEADING

Inserts the current heading.
$LOGOIMAGE

Inserts the logo image; all other text in the string will be ignored.
$PAGE
$PAGE(format)

Inserts the current page number. When a format is specified, uses that numeric format (1 = decimal, i
= lowercase roman numerals, | = uppercase roman numerals, a = lowercase ascii, A = uppercase ascii)

for the page numbers.
$PAGES
$PAGES(format)

Inserts the total page count. When a format is specified, uses that numeric format (1 = decimal, i =
lowercase roman numerals, | = uppercase roman numerals, a = lowercase ascii, A = uppercase ascii)

for the page count.
$TIME

Inserts the current time.
$TITLE

Inserts the document title.
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FONT Attributes

Limited typeface specification is currently supported to ensure portability across platforms and for olde

PostScript printers:

Requested Font Actual Font
Arial Helvetica

Courier Courier

Dingbats Dingbats

Helvetica Helvetica
Monospace DejaVu Sans Mono
Sans DejaVu Sans

Serif DejaVu Serif
Symbol Symbol

Times Times

All other unrecognized typefaces are silently ignored.

Headings

Currently HTMLDOC supports a maximum of 1000 chapters (H1 headings). This limit can be increased b

changing the MAX_CHAPTERS constant in the config.h file included with the source code.

All chapters start with a top-level heading (H1) markup. Any headings within a chapter must be of a lowe
level (H2 to H15). Each chapter starts a new page or the next odd-numbered page if duplexing is selected.

Note:

Heading levels 7 to 15 are not standard HTML and will not likely be recognized
most web browsers.

by

The headings you use within a chapter must start at level 2 (H2). If you skip levels the heading will be shov
under the last level that was known. For example, if you use the following hierarchy of headings:

<H1>Chapter Heading</H1>
;H2>Section Heading 1</H2>
;H2>Section Heading 2</H2>
;H3>Sub-8ection Heading 1</H3>
;H4>Sub-Sub-Section Heading 1</H4>
;H4>Sub-Sub-Section Heading 2</H4>
;H3>Sub-8ection Heading 2</H3>

;'H2>Section Heading 3</H2>

FONT Attributes

6-7



HTMLDOC 1.8.28 Software Users Manual

<H4>Sub-Sub-Section Heading 3</H4>

the table-of-contents that is generated will show:
Chapter Heading

¢ Section Heading 1
¢ Section Heading 2
¢ Sub-Section Heading 1
[(Bub-Sub-Section Heading 1
[Sub-Sub-Section Heading 2
¢ Sub-Section Heading 2
[Sub-Sub-Section Heading 3
¢ Section Heading 3

Numbered Headings

When the numbered headings option is enabled, HTMLDOC recognizes the following additional attributes for
all heading elements:

VALUE="#"

Specifies the starting value for this heading level (default is "1" for all new levels).
TYPE="1"

Specifies that decimal numbers should be generated for this heading level.

TYPE="a"

Specifies that lowercase letters should be generated for this heading level.
TYPE="A"

Specifies that uppercase letters should be generated for this heading level.
TYPE="I"

Specifies that lowercase roman numerals should be generated for this heading level.
TYPE="I"

Specifies that uppercase roman numerals should be generated for this heading level.
Images

HTMLDOC supports loading of BMP, GIF, JPEG, and PNG image files. EPS and other types of image files
are not supported at this time.

Links

External URL and internal (#target and filename.html) links are fully supported for HTML and PDF
output.

When generating PDF files, local PDF file links will be converted to external file links for the PDF viewer
instead of URL links. That is, you can directly link to another local PDF file from your HTML document
with:

<A HREF="filename.pdf">...</A>
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META Attributes

HTMLDOC supports the following META attributes for the title page and document information:

<META NAME="AUTHOR" CONTENT="..."

Specifies the document author.
<META NAME="COPYRIGHT" CONTENT="..."

Specifies the document copyright.
<META NAME="DOCNUMBER" CONTENT=".."

Specifies the document number.
<META NAME="GENERATOR" CONTENT="..."

Specifies the application that generated the HTML file.
<META NAME="KEYWORDS" CONTENT="..."

Specifies document search keywords.
<META NAME="SUBJECT" CONTENT="..."

Specifies document subject.

Page Breaks

HTMLDOC supports four new page comments to specify page breaks. In addition, the older BREAK attribute
still supported by the HR element:

<HR BREAK>

Support for the BREAK attribute is deprecated and will be removed in a future release of HTMLDOC.

Tables

Currently HTMLDOC supports a maximum of 200 columns within a single table. This limit can be increasec
by changing the MAX_COLUMNS constant in the config.h file included with the source code.

HTMLDOC does not support HTML 4.0 table elements or attributes, such as TBODY, THEAD, TFOOT, or
RULES.
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Chapter 7 - GUI Reference

This chapter describes all of the GUI controls in HTMLDOC.

The HTMLDOC GUI

The HTMLDOC GUI (Figures 7-1 through 7-11) is contained in a single window showing the input, output,
and generation options. At the bottom are buttons to load, save, and generate documents.

Document File Operations

HTMLDOC stores the HTML files, settings, and options in .BOOK files. The buttons on the bottom of the
HTMLDOC window allow you to manage these files and generate formatted documents.

New

The New button starts a new document. A confirmation dialog will appear if you have not saved the chang
to the existing document.

Open...

The Open... button retrieves a document that you have saved previously. A file chooser dialog is displaye
that allows you to pick an existing book file.
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Save

The Save button saves the current document._A file chooser dialog is displayed if there is no filename
assigned to the current document.

Note: Saving a document is not the same as generating a document. The book files saved to disk by the Save

and Save As... buttons are not the final HTML, PDF, or PostScript output files. You generate those files by
clicking on the Generate button.

Save As...

The Save As... button saves the current document to a new file. A file chooser dialog is displayed to allow
you to specify the new document filename.

Note: Saving a document is not the same as generating a document. The book files saved to disk by the Save

and Save As... buttons are not the final HTML, PDF, or PostScript output files. You generate those files by
clicking on the Generate button.

Generate

The Generate button generates the current document, creating the specified HTML, PDF, or PostScript
file(s) as needed. The progress meter at the bottom of the window will show the progress as each page or file
is formatted and written.

Note: Generating a document is not the same as saving a document. To save the current HTML files and
settings in the HTMLDOC GUI, click on the Save or Save As... buttons instead.

Close

The Close button closes the HTMLDOC window.
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HP htmidoc.book - HTMLDOC 1.8.24 Commetrcial o ] |
Input Output Page TOC Colors Fonts Po PDF | Security Options
Document Type:  « Book  Continuous — Weh Page
Input Files: =) intro htrnl ~| Add Files...
g] 1-install.html Add URL
=] 3-books html
=) 4-cmdline.html -~ '
=) 5-coihtml
=1 A-himiref himl i i
Logo Image: Browse...
Title Filedmage: Browse...
Help New = Open.. | Save  Save As..  Generate Close
HTMLDOC 1.8.24 Commercial Ready.

Figure 7-1 - The Input Tab

The Input Tab

The input tab (Figure 7-1) lists all of the HTML source files that are used to generate the document. You al
specify the type of document (book or web page) and the title and logo images in this tab.

Document Type
The Book radio button specifies that the input files are structured with headings. The Continuous radic

button specifies unstructured files without page breaks between each file. The Web Page radio butto
specifies unstructured files with page breaks between each file.

Input Files

The Input Files list shows all of the HTML input files that will be used to produce the document.
Double-click on files to edit them.

Add Files...

The Add Files... button displays the file chooser dialog, allowing you to select one or more HTML files to
include in the document.

Edit Files...

The Edit Files... button starts the specified editor program to edit the files selected in the Input Files list.
Select one or more files in the Input Files list to enable the Edit Files... button.
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Delete Files

The Delete Files button removes the selected files from the Input Files list. Select one or more files in the
Input Files list to enable the Delete Files button.

The Delete Files button only removes the files from the Input Files list. The files are not removed from
disk.

Move Up

The Move Up button moves the selected files in the Input Files list up one line in the list. To enable the
Move Up button select one or more files in the Input Files list.

Move Down

The Move Down button moves the selected files in the Input Files list down one line in the list. To enable
the Move Down button select one or more files in the Input Files list.

Logo Image

The Logo Image field contains the filename for an image to be shown in the header or footer of pages, and in
the navigation bar of HTML files.

Click on the Browse... button to select a logo image file using the file chooser dialog.
Title File/Image

The Title File/Image field contains the filename for an image to be shown on the title page, or for a HTML
file to be used for the title page(s).

Click on the Browse... button to select a title file using the file chooser dialog.
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HP htmidoc.book - HTMLDOC 1.8.24 Commetrcial o ] |
Input Dutput Page TOC Colors Fonts Fo PDF | Security Options
Output Ta: = (File Ciirectory
Cutput Path:  htmidoc pdf Browse. ..

Dutput Format: HTRIL Separated HTML Pai= | EEE
Dutput Options; Grayscale « Title Page ' JPEG Big Images

Compression; ;
Mone Fast Best

JPEG Quality: | 75 : '
Good Best

Help New = Open.. | Save  Save As..  Generate Close

HTMLDOC 1.8.24 Commercial Ready.

Figure 7-2 - The Output Tab

The Output Tab

The output tab (Figure 7-2) specifies where your document will be generated, the output format, and some
the generic output options.

Output To

The File radio button selects output to a single file. The Directory radio button selects output to multiple files
in the named directory.

Directory output is not available when generating PDF files.
Output Path

The Output Path field contains the output directory or filename. Click on the Browse... button to choose an
output file using the file chooser dialog.

Output Format
The HTML radio button selects HTML output, the Separated HTML radio button selects HTML output that

is separated into a separate file for each heading in the table-of-contents, the PS radio button sele
PostScript output, and the PDF radio button selects PDF output.

Output Options
The Grayscale check box selects grayscale output for PostScript and PDF files. The Title Page check bo:

specifies that a title page should be generated for the document. The JPEG Big Images check box specifie
that JPEG compression should be applied to continuous-tone images.
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Compression

The Compression slider controls the amount of compression that is used when writing PDF or Level 3
PostScript output.

Note: HTMLDOC uses Flate compression, which is not encumbered by patents and is also used by the

popular PKZIP and gzip programs. Flate is a lossless compression algorithm (that is, you get back exactly
what you put in) that performs very well on indexed images and text.

JPEG Quality

The JPEG Quality slider controls the quality level used when writing continuous-tone images with JPEG
compression.
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HP htmldoc.book - HTMLDOC 1.8.24 Commercial =10 x|
input | Output Page TOC | Colors| Fonts| PS| FLF | Secury | Options|
Page Size: Universal T v 2-Sided  Landscape

Top 0.50in

Left 1.00in 0.50in | Right

Bottorn 0.50in
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Footer;: Heading &  Blank & 123, 2
Mumber Up: 1 #
Help Mew  Open.. Save | Save As.. (Generate Close

HTMLDOC 1.8.24 Commercial Ready.

Figure 7-3 - The Page Tab

The Page Tab

The page tab (Figure 7-3) defines the page header, footer, size, and margins for PostScript and PDF output
Page Size
The Page Size field contains the current page size. Click on the arrow button to choose a standard page siz
HTMLDOC supports the following standard page size names:

* Letter - 8.5x11in (216x279mm)

* A4 - 8.27x11.69in (210x297mm)

* Universal - 8.27x11in (210x279mm)

Click in the Page Size field and enter the page width and length separated by the letter "x" to select a custo
page size. Append the letters "in" for inches, "mm" for millimeters, or "cm" for centimeters.

2-Sided

Click in the 2-Sided check box to select 2-sided (duplexed) output.
Landscape

Click in the Landscape check box to select landscape output.
Top, Left, Right, and Bottom

Click in the Top, Left, Right, and Bottom fields and enter the new margin values to change them. Appenc
the letters "in" for inches, "mm" for millimeters, or "cm" for centimeters.

JPEG Quality 7-7



HTMLDOC 1.8.28 Software Users Manual
Header and Footer

Select the desired text in each of the option buttons to customize the header and footer for the document/body
pages. The left-most option buttons set the text that is left-justified, while the middle buttons set the text that
is centered and the right buttons set the text that is right-justified. Each choice corresponds to the following
text:

Choice Description

Blank The field should be blank.

Title The field should contain the document title.

Chapter Title| The field should contain the current chapter title.

Heading | The field should contain the current heading.

Logo The field should contain the logo image.

1,2,3,... | The field should contain the current page number in decimal format (1, 2, 3,...)

i i The field should contain the current page number in lowercase roman numerals (i,

The field should contain the current page number in uppercase roman numerals (I,

L Ry

a,b,c,... |The field should contain the current page number using lowercase letters.
AB,C,... |The field should contain the current page number using UPPERCASE letters.
nggteer The field should contain the current chapter page number.

1/N,2/N,... | The field should contain the current and total number of pages (n/N).

=

The field should contain the current and total number of pages in the chapts

1/C,2/C,... (n/N).
Date The field should contain the current date (formatted for the current locale).
Time The field should contain the current time (formatted for the current locale).
Date + Time The field should contain the current date and time (formatted for the current

locale).
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Figure 7-4 - The TOC Tab

The TOC Tab

The TOC tab (Figure 7-4) defines the table-of-contents options.

Table of Contents

Select the desired number of levels from the Table of Contents option button.

Numbered Headings

Click in the Numbered Headings check box to automatically number the headings in the document.
Header and Footer

Select the desired text in each of the option buttons to customize the header and footer for ti
tables-of-contents pages. The left-most option buttons set the text that is left-justified, while the middl
buttons set the text that is centered and the right buttons set the text that is right-justified.

Title

Enter the desired title for the table-of-contents in the Title field.
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Figure 7-5 - The Colors Tab

The Colors Tab
The colors tab (Figure 7-5) defines the color and image information that is used for the entire document.
Body Color

The Body Color field specifies the default background color. It can be a standard HTML color name or a
hexadecimal RGB color of the form #RRGGBB. Click on the Lookup... button to pick the color graphically.

Body Image

The Body Image field specifies the default background image. Click on the Browse... button to pick the
background image using the file chooser.

Text Color

The Text Color field specifies the default text color. It can be a standard HTML color name or a hexadecimal
RGB color of the form #RRGGBB. Click on the Lookup... button to pick the color graphically.

Link Color

The Link Color field specifies the default link color. It can be a standard HTML color name or a hexadecimal
RGB color of the form #RRGGBB. Click on the Lookup... button to pick the color graphically.

Link Style

The Link Style chooser specifies the default link decoration.

7-10 Title



HTMLDOC 1.8.28 Software Users Manual

HP htmldoc.book - HTMLDOC 1.8.24 Commercial =10 x|
Input | Output Page TOC Colors Fonts PS| FLF ‘it Options |
Base FontSize: # 4 110 p W
Line Spacing: 4 4 1] (3
Body Typeface: Times s
Heading Typeface: Helvetica #
Header/Footer Size: 4 4 110  p W
Header/Footer Font:  Heletica-Ohligue v
Character et iso-8855-1 €
Options:  Embed Fonts
Help Mew —— Open..  Save  Save As.. Generate Close
HTMLDOC 1.8 24 Commercial Ready.

Figure 7-6 - The Fonts Tab

The Fonts Tab
The fonts tab (Figure 7-6) defines the fonts and character set used by the document.
Base Font Size

The Base Font Size field specifies the size of normal text in the document in points (1 point = 1/72nd inch).
Click on the single arrow buttons to decrease or increase the size by 1/10th point or on the double arr
buttons to decrease or increase the size by whole points.

Line Spacing

The Line Spacing field specifies the spacing between lines as a multiple of the base font size. Click on th
single arrow buttons to decrease or increase the size by 10ths or on the double arrow buttons to decreas
increase the size by whole numbers.

Body Typeface

The Body Typeface option button specifies the typeface to use for normal text. Click on the option button tc
select a typeface.

Heading Typeface

The Heading Typeface option button specifies the typeface to use for headings. Click on the option buttor
to select a typeface.
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Header/Footer Size
The Header/Footer Size field specifies the size of header and footer text in the document in points (1 point

= 1/72nd inch). Click on the single arrow buttons to decrease or increase the size by 1/10th point or on the
double arrow buttons to decrease or increase the size by whole points.

Header/Footer Font

The Header/Footer Font option button specifies the typeface and style to use for header and footer text.
Click on the option button to select a typeface and style.

Character Set

The Character Set option button specifies the encoding of characters in the document. Click on the option
button to select a character set.

Options

The Embed Fonts check box controls whether or not fonts are embedded in PostScript and PDF output.

HR htmidoc.book - HTMLDOC 1.8.24 Commercial =10] x|
POF || Security| Options |
PostScript. Level 1« Level2  Level 3
Send Printer Commands
Include Xerox Job Comments
Help Mew — Open.. Save  SaveAs..  Generate Close
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Figure 7-7 - The PS Tab
The PS Tab
The PS tab (Figure 7-7) contains options specific to PostScript output.

PostScript Level

Click on one of the Level radio buttons to select the language level to generate. PostScript Level 1 is
compatible with all PostScript printers and will produce the largest output files.
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PostScript Level 2 is compatible with most PostScript printers and supports printer commands and JPE
image compression.

PostScript Level 3 is compatible with only the newest PostScript printers and supports Flate imag
compression in addition to the Level 2 features.

Send Printer Commands

The Send Printer Commands check box controls whether or not the output files contain PostScript
setpagedevice commands for the page size and duplex settings. Click in the check box to enable or disable
printer commands.

Printer commands are only available with Level 2 and 3 output and may not work with some printers.

Include Xerox Job Comments

The Include Xerox Job Comments check box controls whether or not the output files contain Xerox job
comments. Click in the check box to enable or disable the job comments.

Job comments are available with all levels of PostScript output.
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